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Introduction to Pro Tools AVoption and

AVoption|XL

AVoption and AVoption XL combine the
powerful audio post-production features of
Pro Tools with integrated support for the
import, capture, and playback of Avid
video media.

AVoption Components

AVoption consists of software and two
Avid video cards that you install in a

Pro Tools audio system. The Digidesign
audio hardware provides digital audio re-
cording, editing, mixing, and processing.
The Avid video hardware provides video
capture and import, full screen video play-
back on an external PAL or NTSC monitor,
video playback in an on-screen window,
and professional quality video compres-
sion.

AVoption XL Components

AVoption XL consists of software, a PCI
card that you install in a Pro Tools audio
system, and an external I/O box that con-
nects to the PCI card. The Digidesign audio
hardware provides digital audio recording,

editing, mixing, and processing. The Avid
video hardware provides video capture and
import, full screen video playback on an
external PAL or NTSC monitor, profes-
sional quality video compression, and the
capability to record and play back uncom-
pressed video.

AVoption Capabilities

AVoption lets you do the following:

e Import and capture NTSC and PAL video

¢ Play the Movie Track with near sample-
accurate precision against audio tracks in
a Pro Tools session

e Spot or Slip the video track to a new time
code location, and spot audio to the
video track

¢ View video edits and media boundaries
in the Movie Track

¢ View the Movie Track as frames that rep-
resent video data

e Play video on an external NTSC or PAL
monitor

¢ Play video in a floating window on your
computer monitor
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You can also do the following:

Import MFM (Media File Manager for-
mat) or MSM (Media Stream Manager
format) video files created on Avid sys-
tems, such as Media Composer,
Xpress/Mac, and AudioVision into the
Movie Track of a Pro Tools session
Capture MSM format video media in the
Movie Track of a Pro Tools session

AVoption XL Capabilities

AVoption XL lets you do the following:

Import and capture NTSC and PAL video
Play the Movie Track with near sample-
accurate precision against audio tracks in
a Pro Tools session

Spot or Slip the video track to a new time
code location, and spot audio to the
video track

View video edits and media boundaries
in the Movie Track

View the Movie Track as frames that rep-
resent video data

Play video on an external NTSC or PAL
monitor

You can also do the following:

Import JFIF video media files from Win-
dows or Macintosh based Avid systems
such as MediaComposer, Symphony, and
Xpress into the Movie Track of a

Pro Tools session

Capture JFIF format video media in the
Movie Track of a Pro Tools session

AVoption and AVoption XL Guide

FilmFrame

The FilmFrame™ option enables 24 FPS
support in AVoption and AVoption XL.
With FilmFrame installed, you can import
and play back Avid Film Composer media
files. For more information on FilmFrame,
contact your Digidesign dealer or visit the
Digidesign Web site.



AVoption Hardware Overview

AVoption hardware consists of two cards:
an Avid Broadcast Video Board (ABVB), and
a Janus Advanced JPEG Compression card.
These cards connect with a ribbon cable.

AVoption Hardware
Capabilities

AVoption hardware does the following:

e Receives composite or component video
signal

¢ Digitizes incoming video

e Compresses digitized video using ad-
vanced JPEG compression

e QOutputs composite and component
video signals

¢ Connects to a second VGA monitor (op-
tional) for computer screen display

Avid Video Resolutions (AVR)

The ABVB captures and plays back video
media with JPEG compression technology,
expressed as Avid Video Resolution (AVR)
levels, in the MSM media format (Media
Composer 7.x-compatible). AVoption can

import both MSM video and MFM video,
which is generated by AudioVision 4.x and
Media Composer 6.x.

AVR levels dictate the amount of JPEG
compression, which determines image
quality and storage requirements for digi-
tized video.

The following resolutions are available:

e Single-field - AVR 2s, AVR 3s, AVR 4s,
AVR 65, AVR 8s, AVR 9s

e Two-field - AVR 12, AVR 70, AVR 70B,
AVR 71, AVR 75, AVR 75B, AVR 77

e Multicamera — AVR 2m, AVR 3m,
AVR 4m, AVR 6m

O Lower numbered AVR levels require less
hard drive space but provide lower resolution
than higher numbered AVR levels.

The lowest resolution is AVR 2m, and the
maximum resolution, AVR 77, is consid-
ered to be broadcast quality.

JPEG Compression and Storage

JPEG compression is not constant, but var-
ies according to the complexity of the foot-
age. For example, a medium shot of a talk-
ing head with a simple background would
compress more and use less disk space than
a panning shot of a stadium full of people.
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The following tables list the approximate
amount of video storage, in minutes per gi-

gabyte, required for each AVR level.

Storage for

AVR 2s - AVR 9s

AVR 30/25 FPS 24 FPS

level Storage Storage
(Minutes/GB) (Minutes/GB)

AVR 2s | 40-74 50-93

AVR 3s | 32-57 40-71

AVR 4s | 19-40 24-50

AVR 6s | 11-33 14-41

AVR 8s | 5-13 6-16

AVR9s | 3-6 4-7

Storage for AVR 2m - AVR 6m

AVR 30/25 FPS 24 FPS

level Storage Storage
(Minutes/GB) (Minutes/GB)

AVR 2m | 47-93 58116

AVR 3m | 25-45 35-60

AVR 4m | 21-36 27-45

AVR 6m | 14-30 18-38

Storage for AVR 12 and AVR 70 - AVR 77

AVR 30/25 FPS

level Storage
(Minutes/GB)

AVR 12 1834

AVR 70 5-11

AVR 70B

AVR 71 4-11

AVR 75 3-8

AVR 75B

AVR 77 2-6
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Required Hardware

To install and use AVoption, you must first
install currently supported Pro Tools 24 or
Pro Tools 24 MIX hardware. Other hard-
ware required for AVoption is listed in this
section, along with system requirements
for AVoption.

Supported Computers

e Power Macintosh 9500

e Power Macintosh 9600

e Power Macintosh G3 (Blue & White)
e Power Macintosh G4

If you are using a Blue & White G3 or a G4,
a qualified expansion chassis is required.

Older G3 Macintosh systems (beige) are
not supported.

O See the Digidesign Web site for the latest
CPU compatibility information.



Minimum System Requirements

Minimum Pro Tools AVoption System Requirements

Item Minimum Requirement

Power Macintosh 9500
Power Macintosh 9600
Power Macintosh G3 (Blue &
White)

Power Macintosh G4

Computer

Pro Tools 24
Pro Tools 24 MIX
Pro Tools 24 MIXplus

Pro Tools audio
hardware

PCI Expansion
Chassis (Blue &
White G3)

Magma 13-Slot
Magma 7-slot

SCSI accelerator ATTO ExpressPCIl Dual-
Channel

(Other SCSI accelerators
may be approved. Check the
Digidesign web site for the
latest compatibility informa-

tion.)

SCSI hard drives at least 2 approved SCSI

hard drives

Sync peripheral Universal Slave Driver (USD)

Sync Hardware

Synchronization Peripheral

AVoption requires a Universal Slave Driver
(USD).

Sync Source

For accurate synchronization during cap-
ture and playback, a house sync source or
black burst generator is required.

Storage Hardware

SCSI Accelerators

To support the high transfer rates required
by AVoption audio and video, the ATTO
Express PCI Dual-Channel SCSI Accelerator
(or other AVoption qualified SCSI accelera-
tor) is required, with audio drives con-
nected to one channel and video drives
connected to the other channel.

SCSI Hard Drives

Using Two Hard Drives

For scenarios that do not require a high
audio track count or a very long video seg-
ment, use two hard drives.

In this scenario, one drive is used to record,
import, and play back audio data, and one
drive is used to record, import, and play
back the video.

Using More Than Two Hard Drives

To get the highest possible performance
from your AVoption system, you should
use more than two hard drives. In this sce-
nario, you can use one, two, three, or four
hard drives for audio data and one, two, or
three hard drives for video data.

Audio AVoption can use multiple hard
drives to store audio data. You should allo-
cate audio tracks to different hard drives
manually. “Round robin” disk allocation is
not recommended in a system that in-
cludes video drives.

Chapter 2: AVoption Hardware Overview



Video AVoption can capture a contiguous
video track to multiple hard drives. This is
useful if the length of your video session
exceeds the 2 GB Mac OS file size limit, or
the storage space available on a single
drive. For example, 50 minutes of video
material, using AVR 77 compression, re-
quires between 9 GB and 25 GB of storage
space. To store this much video, you need
between one and three 9 GB hard drives.
The video is automatically split by AVop-
tion into several files of less than 2 GB on
each disk.

O See the Digidesign Web site for the latest
AVoption compatibility information.
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AVoption|XL Hardware Overview

AVoption XL consists of two hardware
components: a Meridien Digital Media
Board that installs in a PCI slot in your
computer, and a Meridien I/O Box that
connects to the card in your computer. A
Video I/O Board, installed in the Meridien
I/0O Box, provides video inputs and outputs
from your computer to the rest of your
video equipment.

AVoption XL Hardware
Capabilities

AVoption XL hardware does the following:

® Receives composite, component,
S-video, or (optional) SDI video signal

¢ Digitizes incoming video

e Compresses digitized video using ad-
vanced JFIF compression

e Outputs composite, component,
S-video, and (optional) SDI video signals

e Captures and plays back uncompressed
video

JFIF Video Compression

The Meridien board captures and plays
back video media in JPEG File Interchange
Format (JFIF). JFIF compression levels pro-
vide variable levels of compression for your
video project, depending on the recording
input selected, except for 1:1, which is un-
compressed. The available JFIF resolutions
are:
e Single field — 15:1s, 4:1s, 2:1s
e Two fields - 20:1, 10:1, 3:1, 2:1, 1:1 (un-
compressed)

O Higher JFIF compression ratios require less
storage space but provide lower video resolu-
tion than lower compression ratios.

The lowest JFIF resolution is 15:1s, and the
maximum resolution, 1:1, is uncom-
pressed.

JFIF Compression and Storage

JFIF compression is variable. This means
that JFIF compression levels vary slightly,
depending on the video input selected.

0O 1:1 (uncompressed) video storage levels
are not approximate. The amount of data re-
quired to store 1:1 video is always the same,
regardless of the video input used.

Chapter 3: AVoption | XL Hardware Overview



The following tables list the approximate
amount of video storage, in megabytes per
second, required for each JFIF compression

level.

Storage for Single-Field JFIF

Supported CPUs

e Power Macintosh 9600
e Power Macintosh G3 (Blue & White)
e Power Macintosh G4

JFIF 30,25 FPS 24 FPS Older G3 Macintosh systems (beige) are
level Storage Storage not supported.
(MB/second) (MB/second)
(approximate) (approximate) 0O See the Digidesign Web site for the latest
CPU compatibility information.
15:1s 7 .6
4:1s 2.7 2.2
o1s 55 aa Minimum System Requirements
Storage Required for Two-Field JFIF 3:1 Video COmpression or Higher
JFIF 30/25 FPS 24 FPS Minimum AVoption XL System Requirements
level Storage Storage
(MB/second) (MB/second) Item Minimum Requirement
(approximate, (approximate, CPU b Maci h 9600
except 1:1) except 1:1) ower aglntos ’
Blue & White G3 or G4
20:1 1.1 9 )
PCI Expansion Magma 13-Slot
10:1 2.2 1.8 Chassis
3:1 7.3 5.9 SCSI accelerator | Qualified SCSI Accelerator
(ATTO EPCI-DC or Digidesign
2:1 11 8.8 SCSI 64)
1:1 22 17.6 SCSI hard drives Qualified drives are
required; see the Digidesign
Web site for more informa-
tion.
Required Hardware
q Sync peripheral Universal Slave Driver (USD)

To install and use AVoption XL, you must
first install currently supported

Pro Tools 24 or Pro Tools 24 MIX hard-
ware. Other hardware required for
AVoption XL is listed in this section, along
with system requirements for

AVoption XL.
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2:1 Video Compression or 1:1

Uncompressed

Minimum AVoption XL System Requirements

Item

Minimum Requirement

CPU

Power Macintosh 9600,
Blue & White G3 or G4

PCI Expansion
Chassis

Magma 13-Slot

SCSI accelerator
(video)

Qualified SCSI Accelerator
(ATTO EPCI-UL2D LVD Accel-
erator required for 2:1 or
1:1 video compression)

SCSI accelerator
(audio)

Qualified SCSI Accelerator
(ATTO EPCI-DC or Digidesign
SCSI 64 required for 2:1 or
1:1 video compression)

SCSI hard drives

Qualified drives are
required; see the Digidesign
Web site for more informa-
tion.

Striped hard
drives

A 2-way stripe is required for
2:1 compressed video.

A 4-way stripe is required for
uncompressed (1:1) video.

Sync peripheral

Universal Slave Driver (USD)

Sync Hardware

Synchronization Peripheral

AVoption XL requires a Universal Slave

Driver (USD).

Sync Source

For accurate synchronization during cap-
ture and playback, a house sync source or
black burst generator is required.

Storage Hardware

SCSI Accelerators

To support the high transfer rates required
by AVoption XL video, a qualified SCSI ac-
celerator is required, with audio drives con-
nected to one channel and video drives
connected to the other channel. For 2:1
compression or 1:1 uncompressed video, 2
SCSI accelerators are required.

SCSI Hardware and Drives with
Video Compression Level 3:1 or
Higher

If you are using 3:1 video compression or
higher at all times, then your system re-
quires only a single dual channel SCSI ac-
celerator, the ATTO EPCI-UL2D or EPCI-
DC, or the Digidesign SCSI 64, with audio
drives connected to one channel and video
drives connected to another.

0 Other SCSI accelerators may be qualified.
Refer to the compatibility information on the
Digidesign Web site for more information.

Using Two Hard Drives

For scenarios that do not require a high
audio track count or a very long video seg-
ment, use two hard drives.

In this scenario, one drive is used to record,
import, and play back audio data, and one
drive is used to record, import, and play
back the video.

Chapter 3: AVoption | XL Hardware Overview



Using More Than Two Hard Drives

To get the highest possible performance
from your AVoption XL system, you should
use more than two hard drives. In this sce-
nario, you can use one, two, three, or four
hard drives (volumes) for audio data and
one, two, or three hard drives (volumes) for
video data.

O Note that striped volumes appear to
AVoption XL as a single volume.

Audio AVoption XL can store audio data to
multiple hard drives. You should allocate
audio tracks to different hard drives manu-
ally. “Round robin” disk allocation is not
recommended in a system that includes
video drives.

Both of these options are covered in detail
in your Pro Tools Reference Guide.

Video AVoption XL can capture a contigu-
ous video track to multiple hard disks. This
is useful if the length of your video session
exceeds the storage space available on a
single drive. For example, 26 minutes of
video material, using 3:1 compression, re-
quires approximately 11.1 GB of storage
space. To store this much video, you need
two 9 GB hard drives.

SCSI Hardware and Drives with
Video Compression Level 2:1 or
11

If you are using 2:1 or 1:1 video compres-
sion, your system requires two SCSI acceler-
ators: the ATTO EPCI-UL2D LVD accelera-

tor, and the ATTO EPCI-DC or Digidesign
SCSI 64. In this scenario, video drives are
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connected to the EPCI-UL2D, and audio
drives are connected to the EPCI-DC or
SCSI 64.

Striped Drive Requirements

“Striped” drives are configured in such a
way that multiple hard drives behave as if
they are one hard drive. This makes higher
data throughput possible. 4-way striped
drives (4 drives acting as one) are required
when capturing, importing, or playing un-
compressed (1:1) video. 2-way striped
drives (2 drives acting as one) are required
when capturing, importing, or playing 2:1
compressed video.

2-way striped drives should be connected
in pairs to the EPCI-UL2D accelerator, with
1 drive connected to each channel.

4-way striped drives should be connected
in pairs to the EPCI-UL2D accelerator, with
2 drives connected to each channel.



chapter 4

Installing AVoption

This chapter discusses the installation and
configuration of AVoption software and
hardware.

Installing a New AVoption
System

If you do not already have currently sup-
ported Pro Tools TDM hardware installed,
you must install AVoption as a new system.

To install a new AVoption system:

1 Install Pro Tools software using the

Pro Tools Installer CD-ROM. The first time

you launch Pro Tools, you are prompted to

enter your authorization code, which is in-
cluded in your TDM Software Installation

Guide.

2 Install AVoption software. See “Installing

AVoption Software” on page 12.

3 Install Pro Tools and AVoption hardware.

e Determine the proper PCI slots for your
installation. See “AVoption PCI Slot Con-
figurations” on page 12.

e Install Pro Tools hardware using the in-
structions in your TDM Hardware Instal-
lation Guide.

¢ Install AVoption hardware. See “Install-
ing AVoption Hardware” on page 12.

Installing AVoption as an
Upgrade

If you have currently supported

Pro Tools TDM hardware installed in your
system, then you can install AVoption as
an upgrade.

A You must have the latest version of
Pro Tools (included on the Installer CD-ROM)
installed before you install AVoption.

To install AVoption as an upgrade:

1 Install AVoption software. See “Installing
AVoption Software” on page 12.

2 Install AVoption hardware. Determine
the proper PCI slots for your installation
using “AVoption PCI Slot Configurations”
on page 12. You may be required to rear-
range Pro Tools hardware that is already in-
stalled. See “Installing AVoption
Hardware” on page 12 to install the AVop-
tion hardware.

Chapter 4: Installing AVoption
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Installing AVoption
Software

AVoption includes the following software:
¢ Pro Tools Installer CD-ROM
e AVoption Authorizer diskette

AVoption is copy protected with a key disk
system. After you install the software from
CD-ROM, the Authorizer diskette permits
you to authorize and use a single copy of
AVoption.

AVoption software is installed in a specific
location in your System folder, and should
not be moved or altered. The Authorizer
diskette permits you to reclaim authoriza-
tion from your hard drive if you wish to in-
stall AVoption on a different hard drive, or
if you wish to re-initialize or format your
drive.

To install AVoption software:
1 Insert the Pro Tools Installer CD-ROM in
your CD-ROM drive.

2 Follow the installation instructions to in-
stall AVoption.

To authorize AVoption:

« When prompted, insert the Authorizer
diskette into your floppy drive.
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Installing FilmFrame

FilmFrame is optional, and copy protected
with a key disk system. If you purchase this
option, you will receive a FilmFrame Au-
thorizer diskette that permits you to autho-
rize and use this option.

To authorize FilmFrame:

= Insert the Authorizer diskette into your
floppy drive, and authorize FilmFrame.

Installing AVoption
Hardware

To install your AVoption hardware, first de-
termine the PCI slots where you will install
the hardware, using the following tables.

AVoption PCI Slot
Configurations
The following slot configurations are rec-

ommended for video and audio hardware
installations.



Power Macintosh 9500/9600

Power Macintosh 9500 PCI slots with AVoption

Slot Card

1 Macintosh graphics accelerator
2 d24 or MIX Core card

3 MIX Farm or DSP Farm (if any)
4 SCSI accelerator

5 Janus Advanced JPEG card

6 ABVB card

Power Macintosh 9500/9600 PCI slots with

Power Macintosh G3 (Blue & White)

The Blue & White G3 has only three PCI

slots. If you use this CPU, you must use a
Magma 7-Slot or 13-Slot Expansion Chas-
sis.

A In the Magma 7-Slot chassis, the Janus Ad-
vanced JPEG card must be placed in the first

slot, and the ABVB card must be placed in the
second slot to avoid potential equipment dam-
age.

Power Macintosh G3 (Blue & White) PCI slots with
AVoption and a Magma 7-Slot Expansion Chassis

. . - Slot Card
Expansion Chassis (Magma or Bit3)
Slot Card CPU 1 PCI Expander card (connects
CPU to chassis)
CPU 1 Empt
Py CPU 2 Empty
CPU 2 Chassis Expander card (con-
nects CPU to chassis) CPU 3 SCSI Accelerator
CPU 3 Macintosh graphics accelerator Chassis Chassis Backplane card
Backplane
CPU 4 SCSI Accelerator Slot
CPU 5 Janus Advanced JPEG card Chassis 1 Janus Advanced JPEG card
CPU 6 ABVB card Chassis 2 ABVB card
Chassis Chassis Backplane card Chassis 3 d24 or MIX Core
Backplane . L. . .
Slot Chassis 4 Remaining Digidesign cards to
- end of chassis (max. 10 includ-
Chassis 1 d24 or MIX Core Chassis 5 ing core)
Chassis Remaining Digidesign cards to Chassis 6
(remaining) end of chassis (max. 10 includ- Chassis 7

ing core)
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Power Macintosh G3 (Blue & White) PCI slots with
AVoption and a Magma 13-Slot Expansion Chassis

Power Macintosh G4

The G4 has only three PCI slots. If you use
this CPU, you must use a Magma 7-slot or
13-slot expansion chassis.

A In the Magma 7-Slot Expansion Chassis,
the Janus Advanced JPEG card must be placed
in the first slot, and the ABVB card must be
placed in the second slot to avoid potential
equipment damage.

Power Macintosh G4 PCI slots with AVoption and a
Magma 7-Slot Expansion Chassis

Slot Card

CPU 1 PCI Expander card (connects
CPU to chassis)

CPU 2 Empty

CPU 3 SCSI Accelerator

Chassis Chassis Backplane card

Backplane

Slot

Chassis 1 ABVB card

Chassis 2 Janus Advanced JPEG card

Chassis 3 d24 or MIX core

Chassis 4 Remaining Digidesign cards to
end of chassis (max. 10 includ-

Chassis 5 ing core)

Chassis 6

Chassis 7

Chassis 8

Chassis 9

Chassis 10

Chassis 11

Chassis 12

Chassis 13
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Slot Card

CPU 1 SCSI Accelerator card

CPU 2 PCI Expander card (connects
CPU to chassis)

CPU 3 Empty

Chassis Chassis Backplane card

Backplane

Slot

Chassis 1 Janus Advanced JPEG card

Chassis 2 ABVB card

Chassis 3 d24 or MIX Core

Chassis 4 Remaining Digidesign cards to
end of chassis (max. 10 includ-

Chassis 5 ing core)

Chassis 6

Chassis 7




Power Macintosh G4 PCI slots with AVoption and a
Magma 13-Slot Expansion Chassis

Slot Card

CPU 1 SCSI Accelerator

CPU 2 PCI Expander card (connects
CPU to chassis)

CPU 3 Empty

Chassis Chassis Backplane card

Backplane

Slot

Chassis 1 ABVB card

Chassis 2 Janus Advanced JPEG card

Chassis 3 d24 or MIX core

Chassis 4 Remaining Digidesign cards to
end of chassis (max. 10 includ-

Chassis 5 ing core)

Chassis 6

Chassis 7

Chassis 8

Chassis 9

Chassis 10

Chassis 11

Chassis 12

Chassis 13

Audio Hardware

Refer to your TDM Hardware Installation
Guide for audio hardware installation infor-
mation.

A You may be required to move hardware that
is already installed to new PCI slot locations in
your computer or expansion chassis, based on
the information above.

Installing AVoption Video
Hardware

To install AVoption video hardware:

1 Unplug and open your Macintosh com-
puter or your Magma expansion chassis ac-
cording to the instructions included with
it.

2 Release any static electricity by touching
the power supply of the CPU, or another
grounded item.

3 Remove the ABVB card from the anti-
static bag, being careful to handle it only
by the edges.

oomoo
oo oo

oooo

o oooo
cooo

ooo
ooo

ABV Card and ribbon cable

4 Line up the ABVB card with the installa-
tion slot, and slide the card into place gen-
tly so the PCI connector is lined up with
the PCI slot.

Chapter 4: Installing AVoption
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5 Press down firmly on the card with even
pressure. The connector should click into
place in the PCI slot.

PCI Card alignment and installation

6 Repeat this process for the Janus Ad-
vanced JPEG card, making sure that you
place it in the proper slot.

Janus card

Ribbon cable

ABVB card and Janus Advanced JPEG card installed

7 Attach the ribbon cable from the ABVB
board to the connector on top of the Janus
Advanced JPEG card by aligning the cable
end with the connector, and gently press-
ing it onto the card until it clicks into
place.

8 Close the computer or expansion chassis.

16 AVoption and AVoption XL Guide

Installing the Digidesign
SCSI 64 / ATTO EPCI-DC
SCSI Accelerator Card

nl 0 0 ]

Digidesign SCSI64 / ATTO EPCI-DC SCSI Accelerator

To install the ATTO ExpressPCI Dual-Channel
SCSI Accelerator:

1 Unplug and open your Macintosh com-
puter or expansion chassis according to the
instructions included with it.

2 Release any static electricity by touching
the power supply, or another grounded
item.

3 Remove the ATTO card from the anti-
static bag, being careful to handle it only
by the edges.

4 Line up the ATTO card with the installa-
tion slot, and slide the card into place gen-
tly so the PCI connector is aligned with the
PCI slot.

5 Press down firmly on the card with even
pressure. The connector should click into
place in the PCI slot.

6 Fasten the card in place using the in-
cluded screw to attach the card bracket to
the computer mounting bracket.



Initializing Hard Drives

Refer to the information in the AVoption
Release Bulletin and on the Digidesign Web
site for the latest hard drive initialization
information.

AVoption Video
Connections

The ABVB Video Cable

AVoption includes a cable that provides
nine coaxial video connections to connect
video and sync components of your system

to the ABVB card.
gtﬁzﬂ
Eggj

=g

N

ABVB video connector cable

To connect the ABVB cable to the ABVB card:
1 Remove the ABVB cable from the protec-
tive plastic bag.

2 Connect the single connector end to the
matching connector on the ABVB card.

3 Tighten the screws to lock the cable in
place.

Video Connectors on the ABVB Cable

GL IN This “Gen Lock” connector is used to
connect the ABVB card to an external refer-
ence video (black burst) source.

CV OUT This connector provides Compos-
ite Video out. You can use this output to
connect an NTSC or PAL video monitor for
video viewing. You can also connect this
output to a composite input on your VTR.

0O Many NTSC video monitors include outputs
that recreate a video input signal. You can con-
nect the CV OUT from the ABVB to an NTSC
monitor, then connect an output from the mon-
itor to your VTR to record from AVoption.

Y OUT, B-Y OUT, R-Y OUT These connectors

provide Component (RGB) Video outputs.
You can use these to connect a video refer-
ence monitor or VIR that has Component
Video inputs.

CV IN This input is used to get Composite
Video from an external source into AVop-
tion. Connect this to your video source.

This connector can also be used in a video
loop with the USD. The output of your VTR
can be connected to the Video In connec-
tor on the USD, then the Video Out con-
nector on the USD can be connected to this
CV IN cable. You might use this connec-
tion to “window burn” with the USD.

Y IN, B-Y IN, R-Y IN These inputs are used to
get Component Video signals from an ex-
ternal source into AVoption.

Chapter 4: Installing AVoption
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To connect a BNC connector:

= Slide the end of the BNC connector over
the matching BNC connection, and twist
the BNC connector clockwise until it locks
into place.

To remove a BNC connector:

= Grip the BNC connector you wish to re-
move and twist it counter-clockwise until it
comes loose.

M T——

BNC connector

USD Connections

The following illustrations show USD con-
nections. The Universal Slave Driver User’s
Guide provides more specific information
about this peripheral.

Black burst VTR out
Serial cable |

to Maclzintosh
¥o

VIDEO REF MAC SERIAL VIDEO

I
CV IN (ABVB)
USD video connections

OUT
9 PIN OUT SUPERC OCK (256X)

85-264VAC, 47-63HZ, 115 W

to Slave Clock In
(audio interface)

USD connection to an audio interface

9 PIN IN/ACC
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Connecting House Sync or
Black Burst

In most AVoption setups, three black burst

or “house sync” connections are required.

These connections are:

e to VIDEO REF in on the USD

e toavideo input on your VTR (a video ref-
erence input if available)

¢ to the GL IN connector from the ABVB
cable

Read the documentation for your black
burst generator for more information.

Connecting a VIR

A VTR can be used to provide video input
and to record video output from AVoption.
In most situations, there are three connec-
tions you need to make:

¢ connect a black burst or house sync out-
put to a video input on your VTR (prefer-
ably a reference video input)

e connect the ABVB cable’s CV IN and/or
Component IN connectors to the corre-
sponding output or outputs on your VIR

e connect the ABVB cable’s CV OUT
and/or Component OUT connectors to
the corresponding inputs on your VIR
—or-

e connect the ABVB cable’s CV OUT
and/or Component OUT connectors to
the corresponding input on an NTSC or
PAL video monitor, then connect the
outputs from this monitor to corre-
sponding inputs on your VTR.



Connecting an External Video
Reference Monitor

Connect an external NTSC or PAL video
reference monitor using the ABVB cable’s
Composite or Component Video outputs.

Centralized Video Switching
and Routing

Many professional facilities have central-
ized video switching and routing systems.
These systems can be used to route AVop-
tion’s inputs and outputs to flexible input
sources and output destinations.

Chapter 4: Installing AVoption 19



Sample AVoption Setup

Diagrams

Macintosh
. video card
Macintosh ATTO card
monitor Channel 1
“—p
Macintosh
computer
Audio
Macintosh drives
i . ATTO card
monitor Composite Channel 2
or —>
Digi card
] ~| @ -
Video QA _pl o
monitor 2,2 2
= 5 . A h g—
S — % o| & 5 . 8 Audio Interface
e & 5 @ % g v (888/24)
pil 5] © ] <
Black burst 22| s z
generator ’ s| § s| = L
< (&) (o} =
A 1 191 I —
2|l | @
15| 3 51
to a video o| & @ 8
ref input = 2 o
Q
v 2 | Universal
SooD 0OO g OOD ooOo Video out o | Slave Driver
El 0o —— 4’
o Video In —
00 000
00000 ‘
Video deck
Video Ref in
Sample ABVB video setup
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External video monitor

VIDEO

CV OUT (from ABVB)

‘@’ POWER

REMOTE

Component video outputs (ABVB)

£
3

Video deck Video in panel
AUDIO INPUT VIDEO INPUT
CH-1 CH-2
'
. —

AUDIO OUTPUT VIDEO OUTPUT

CH-1 CH-2 | MONITOR Y

REFDEO (b R_Y
- o ¥

/
== @D i

ABVB cable

Video out panel

M

to Component Video
inputs (ABVB)

Blackburst generator
to Ref Video input

GL IN (ABVB) E@?ﬂl 2 3[@3 on video deck

'?_Tgi' e
|

to USD / VSD

Video connections for component video, blackburst, and external monitor
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Installing AVoption XL

This chapter discusses the installation and
configuration of AVoption XL software and
hardware.

¢ Install AVoption XL hardware. See “In-
stalling AVoption XL Hardware” on
page 24.

Installing a New
AVoption XL System

If you do not already have currently sup-
ported Pro Tools hardware installed, you
must install AVoption XL as a new system.

To install a new AVoption XL system:

1 Install Pro Tools software using the

Pro Tools Installer CD-ROM. The first time
you launch Pro Tools, you are prompted to
enter a serial number, which is included in
your TDM Software Installation Guide.

2 Install AVoption XL software. See “In-
stalling AVoption XL Software” on page 24.

3 Install Pro Tools and AVoption XL hard-

ware.

e Determine the proper PCI slots for your
installation. See “AVoption XL PCI Slot
Configurations” on page 24.

e Install Pro Tools hardware using the in-
structions in your Pro Tools Hardware In-
stallation Guide.

Installing AVoption XL as
an Upgrade

If you have currently supported

Pro Tools TDM hardware installed in your
system, then you can install AVoption XL
as an upgrade.

A You must have the latest version of
Pro Tools (included on the Installer CD-ROM)
installed before you install AVoption XL.

To install AVoption XL as an upgrade:

1 Install AVoption XL software. See “In-
stalling AVoption XL Software” on page 24.

2 Install AVoption XL hardware. Deter-
mine the proper PCI slots for your installa-
tion using “AVoption XL PCI Slot
Configurations” on page 24. You may be
required to rearrange Pro Tools or other
cards that are already installed. See “Install-
ing AVoption XL Hardware” on page 24 to
install the AVoption XL hardware.

Chapter 5: Installing AVoption XL
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Installing AVoption XL
Software

AVoption XL includes the following soft-
ware:
¢ Pro Tools Installer CD-ROM

e AVoption XL Authorizer floppy disk

AVoption XL is copy protected with a key
disk system. After you install the software
from CD-ROM, the Authorizer diskette per-
mits you to authorize and use a single copy
of AVoption XL.

AVoption XL software is installed in a spe-
cific location in your System folder, and
should not be moved or altered. The Au-
thorizer diskette permits you to reclaim au-
thorization from your hard drive if you
wish to install AVoption XL on a different
hard drive, or if you wish to re-initialize or
format your drive.

To install AVoption XL software:
1 Insert the Pro Tools Installer CD-ROM in
your CD-ROM drive.

2 Follow the installation instructions to in-
stall AVoption XL.

To authorize AVoption XL:

« When prompted, insert the Authorizer
diskette into your floppy drive.
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Installing FilmFrame

FilmFrame is optional, and copy protected
with a key diskette system. If you purchase
this option, you will receive a FilmFrame
Authorizer diskette that permits you to au-
thorize and use this option.

To authorize FilmFrame:

= Insert the Authorizer diskette into your
floppy drive, and authorize FilmFrame.

Installing AVoption XL
Hardware

To install your AVoption XL hardware, first
determine the PCI slots where you will in-
stall the hardware, using the following ta-
bles.

AVoption XL PCI Siot
Configurations

The following slot configurations are rec-
ommended for video and audio hardware
installations.

Power Macintosh G3 (Blue & White)

The Blue & White G3 has only three PCI
slots. If you use this CPU, you must use a
Magma 7-slot 13-slot expansion chassis.



Power Macintosh 9500/9600 PCI Slots with
Expansion Chassis (Magma or Bit3)

Power Macintosh G3 (Blue & White) PCI slots with
AVoption XL and a Magma 13-Slot Magma Expansion

Slot Card Chassis
CPU 1 Video Accelerator Slot Card
CPU 2 CPU1 Audio SCSI Accelerator (ATTO
EPCI-DC or Digidesign SCSI 64)
CPU 3
CPU 2 PCI Expander Card (connects
CPU 4 Audio SCSI Accelerator (ATTO CPU to chassis)
EPCI-DC or Digidesign SCSI 64)
CPU 3
CPU 5
Chassis Chassis Backplane Card
CPU 6 Backplane
Slot
Chassis
Backplane Chassis 1 Video SCSI Accelerator (ATTO
Slot EPCI-UL2D LVD)
Chassis 1 Video SCSI Accelerator (ATTO Chassis 2
EPCI-UL2D LVD)
Chassis 3
Chassis 2
Chassis 4 Digital Media Board
Chassis 3
Chassis 5
Chassis 4 Digital Media Board
Chassis 6
Chassis 5
Chassis 7
Chassis 6
Chassis 8 d24 or MIX core card
Chassis 7
Chassis 9 Remaining Digidesign cards to
Chassis 8 d24 or MIX core card end of chassis (max. 6 including
Chassis 10 | ¢ore)
Chassis 9 Remaining Digidesign cards to -
end of chassis (max. 6 including Chassis 11
Chassis 10
core) Chassis 12
Chassis 11
Chassis 13
Chassis 12
Chassis 13

Chapter 5: Installing AVoption XL
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Power Macintosh G4

The G4 has only three PCI slots. If you use
this CPU, you must use a Magma 13-Slot
Expansion Chassis.

Power Macintosh G4 PCI slots with AVoption and a
Magma 13-Slot Expansion Chassis

Slot Card

CPU 1 Audio SCSI Accelerator (ATTO
EPCI-DC or Digidesign SCSI 64)

CPU 2 PCI Expander card (connects
CPU to chassis)

CPU 3 Empty

Chassis Chassis Backplane card

Backplane

Slot

Chassis 1 Video SCSI Accelerator (ATTO
EPCI-UL2D LVD)

Chassis 2

Chassis 3

Chassis 4 Digital Media Board

Chassis 5

Chassis 6

Chassis 7

Chassis 8 d24 or MIX core

Chassis 9 Remaining Digidesign Cards to
end of chassis

Chassis 10

Chassis 11

Chassis 12

Chassis 13
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Audio Hardware

Refer to your Pro Tools Hardware Installation
Guide for audio hardware installation infor-
mation.

O You may be required to move hardware that
is already installed to new PCI slot locations in
your computer or expansion chassis, based on
the information above.

Installing AVoption XL Video
Hardware

To install AVoption XL video hardware:

1 Unplug and open your Magma Expan-
sion Chassis according to the instructions
included with it.

2 Release any static electricity by touching
the power supply of the chassis, or another
grounded item.

3 Remove the Digital Media Board from
the anti-static bag, being careful to handle
it only by the edges.

4 Line up the Digital Media Board with the
installation slot, and slide the card into
place gently so the PCI connector is lined
up with the PCI slot.



5 Press down firmly on the card with even
pressure. The connector should click into
place in the PCI slot.

PCI Card alignment and installation

6 Close the computer or expansion chassis.

7 Attach the connector cable from the Dig-
ital Media Board (connector labeled M) to
the Computer connector on the Meridien
1/0O Box.

=~y
g\\v‘:
Gy @ 00e0esol ..
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Connecting the Digital Media Board to the Breakout
Box

Installing the ATTO EPCI-
UL2D SCSI Accelerator

[ 0 0 [l

ATTO UL2D LVD SCSI Accelerator

To install the ATTO EPCI-UL2D SCSI
Accelerator:

1 Unplug and open your expansion chassis
according to the instructions included with
it.

2 Release any static electricity by touching
the power supply, or another grounded
item.

3 Remove the ATTO card from the anti-
static bag, being careful to handle it only
by the edges.

4 Line up the ATTO card with the installa-
tion slot, and slide the card into place gen-
tly so the PCI connector is aligned with the
PCI slot.

5 Press down firmly on the card with even
pressure. The connector should click into
place in the PCI slot.

6 Fasten the card in place using the in-
cluded screw to attach the card bracket to
the computer mounting bracket.

Chapter 5: Installing AVoption XL
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AVoption XL Video
Connections

The following video I/O capabilities are

available with the Meridien I/O Box:

¢ Inputs for composite, component (Y, R-Y,
B-Y), S-Video, and (optional) SDI

¢ Outputs for composite, component (Y, R-
Y, B-Y), S-Video, and (optional) SDI

e Video Ref input to allow the video to be
locked to an external source such as
house sync or a black burst generator.

A Only one video input source can be used at
a time. See “Recording Video” on page 35 for
more information.

A The Meridien 1/0 Box can only output from
either S-Video or Component outputs. You
must set this option in your Movie Track. See
“Setting S-Video or Component Output” on
page 34 for instructions.
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Meridien 1/0 Box

The following sections provide figures and
tables that describe the function of the Me-
ridien I/O Box video I/0O.

Meridien 1/0 Box Front Panel
Indicators

The front panel of the Meridien I/O box
(see Figure 1) has six indicators and a
power switch. When you turn on the Meri-
dien I/O Box, the indicators turn on and off
as it goes through a power-on self-test
(POST). After the POST, the POWER indica-
tor remains lit.

A Some indicators do not light, or do not indi-
cate correctly, when used with AVoption XL
(see illustration). To determine this informa-
tion, use the indicators on your USD, or your
Session Setup window.



Sample rate Audio sync Pull down
(44.1 or 48 (this does (this does not light)

is always lit) not light) /

Avid

o
b 441 kHZ AUDIO SYNC PULL DOWN |

s 48 VIDEOSYNC ~ ® POWER ‘

1
Video sync Power indicator Power switch

Figure 1. Meridien 1/0 Box front panel
Video 1/0 Connectors

??Q???Pﬂ@f@

@\\",

i e \ / /

Figure 2. Meridien I/0 Box rear panel showing video connectors
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Table 1. Video I/0 Board Identifiers

Number Label Function

1 COMPONENT Y IN Video Y component input, BNC connector. Connects to
analog video output of decks.

2 COMPONENT R-Y IN Video R-Y component input, BNC connector. Connects to
analog video output of decks.

3 COMPONENT B-Y IN Video B-Y component input, BNC connector. Connects to
analog video output of decks.

4 COMPONENT Y OUT Video Y component (Betacam) output, BNC connector.
Connects to analog video input of decks.

5 COMPONENT R-Y OUT Video R-Y component (Betacam) output, BNC connector.
Connects to analog video input of decks.

6 COMPONENT B-Y OUT Video B-Y component (Betacam) output, BNC connector.
Connects to analog video input of decks.

7 SDI IN (optional) Serial digital input, BNC connector. Connects to a serial
digital output from a digital video source.

8 SDI OUT1 (optional) Serial digital output number 1, BNC connector. Connects
to VTR input, a video monitor, or other serial digital device.

9 SDI OUT2 (optional) Serial digital output number 2, BNC connector. Connects
to VTR input, a video monitor, or other serial digital device.

10 SDI OUT3 (optional) Serial digital output number 3, BNC connector. Connects
to VTR input, a video monitor, or other serial digital device.

11 SYSTEM Audio and video I/0 connector from the system interface
board.

12 LTC OUT Sends LTC time code out (not used with AVoption XL).

13 LTC IN Brings LTC time code in (not used with AVoption XL).

14 SLAVE CLOCK OUT Clock output, BNC connector (not used with AVoption XL)

15 S-VIDEO OUT Super-video output, 4-pin connector. Connects to analog
video input of decks.

16 COMPOSITE OUT3 Composite video output, BNC connector. Connects to ana-
log video input of decks or monitor.
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Table 1. Video I/0 Board Identifiers(Continued)

Number Label Function

17 COMPOSITE OUT2 Composite video output, BNC connector. Connects to ana-
log video input of decks or monitor.

18 COMPOSITE OUT1 Composite video output, BNC connector. Connects to ana-
log video input of decks or monitor.

19 S-VIDEO IN Super-video input, 4-pin connector. Connects to analog
video output of decks.

20 COMPOSITE IN Composite video input, BNC connector. Connects to
analog video output of decks.

21 Video Reference (REF) Black burst or house sync input, BNC connector. Synchro-
nizes the system with the global clock source provided by
the house sync or black burst generator.

USD Connections

The following illustrations show USD con-
nections. The Universal Slave Driver User’s
Guide provides more specific information

about this peripheral.

Black burst VTR out
Serial cable
to Maclzintosh

w~
°”TL

VIDEO REF

to COMPOSITE VIDEO input
USD video connections

9 PIN IN/ACC

85-264VAC, 47-63HZ, 115 W

ER CJOCK (256X)

OUT
SUP

9 PIN OUT

to Slave Clock In
(audio interface)

USD connection to an audio interface

Connecting House Sync or
Black Burst

In most AVoption XL setups, three black
burst or “house sync” connections are re-
quired. These connections are:

e to VIDEO REF in on the USD

e toavideo input on your VIR (a video ref-
erence input if available)

¢ to the VIDEO REF connector on the Me-
ridien I/O Box

Read the documentation for your black
burst generator for more information.

Connecting a VIR

A VTR can be used to provide video input

and to record video output from

AVoption XL. In most situations, there are

three connections you need to make:

e connect a black burst or house sync out-
put to a video input on your VTR (prefer-
ably a reference video input)

Chapter 5: Installing AVoption XL
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e connect the Meridien I/O Box COMPOS-
ITE IN, COMPONENT IN, S-VIDEO IN, or
SDI IN connectors to the corresponding
output or outputs on your VIR

e connect the Meridien I/O Box COMPOS-
ITE OUT, COMPONENT OUT, S-VIDEO
OUT, or SDI OUT connectors to the cor-
responding inputs on your VIR
—or-

e connect the Meridien I/O Box COMPOS-
ITE OUT or COMPONENT OUT connec-
tors to the corresponding input on an
NTSC or PAL video monitor, then con-
nect the outputs from this monitor to
corresponding inputs on your VTR.

A The Meridien 1/0 Box can only output from
either S-Video or Component outputs. You
must set this option in your Movie Track. See
“Setting S-Video or Component Output” on
page 34 for instructions.

Connecting an External Video
Reference Monitor

Connect an external NTSC or PAL video
reference monitor to a COMPOSITE,
COMPONENT, S-VIDEO, or SDI output.

Centralized Video Switching
and Routing

Many professional facilities have central-
ized video switching and routing systems.
These systems can be used to route
AVoption XL’s inputs and outputs to flexi-
ble input sources and output destinations.
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chapter 6

Recording or Importing the Movie Track

You can capture a video file by actually re-

cording the video in through the inputs on optens
your ABVB connector cable (AVoption) or Track name IComlpression
eve
the inputs on your Meridien 1/O Box R
R i . ecord "
(AVoption XL), or import a file created in a o

Fres | | rloody f1—1st video record drive
2nd video record drive

|__cawell_fi—3rd video record drive

compatible Avid video editing and compo-
sition program.

View Approximate available
options record time

The Movie Track

__Video format
The Movie Track holds the movie you cap- to record
ture or import into Pro Tools. A Pro Tools Vides Farmat _
session with AVoption or AVoption XL can r— EEE\ _.“SSSE‘S"?) 1/ Box
contain one Movie Track. so! from
Track lJlth __Video output
options S-Yideo format
Track name %\)’rg}pressmn Figure 4. Movie Track controls (AVoption XL)

Record

[_svoptiont | =] aiiRes | To cr new Movie Track:
1st video record drive o create a ne ovie Track:

2nd video record drive = Choose Movie > New Movie Track.
|_#udie-1 41—3rd video record drive

| _frames || The new, empty track appears in the Edit

View Approximate available window.
options record time

Track height

To name the Movie Track:

Video Format » B =S

Wideo Input M PaL
‘Yideo Format 3

Yidea Input (3 Composite
Component

Figure 3. Movie Track controls (AVoption)

Video format 1 Double-click the Track Name button to
to record open the Name and Comments dialog.

ABVB inputs

' 2 Type a name and click OK. You can also
o record from

add comments here.

Chapter 6: Recording or Importing the Movie Track 33



To delete the Movie Track:
1 Select the track by clicking on the Track
Name button in the Edit window.

2 Choose File > Delete Selected Tracks.

To clear all video from the Movie Track:
= Choose Movie > Clear Movie Track.

Setting S-Video or
Component Output

(AVoption XL only)

The Meridien I/O Box can only output
from either S-Video or Component out-
puts. This choice must be made in the soft-
ware, and echoed in the physical connec-
tions you use to output signals.

To select component video outputs in
AVoption XL:

1 On the Movie Track, click the Track Op-
tions pop-up. See Figure 4 on page 33.

2 Use the Video Output pop-up menu to
select the outputs you would like to use:
Component or S-Video.
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Movie Track Options

The Movie Track can be viewed in frames or
in blocks. Frames allow you to see an over-
view of the actual video content in a ses-
sion. Blocks allow you to see where clips in
the original project begin and end, and the
names of clips.

Frames

In Frames mode, video data is displayed as
pictures in the Movie Track. These pictures
are computed based on the video image,
and scale according to your track zoom set-
tings and track height. They do not provide
a frame-accurate reference, but allow you
to easily find a scene or sequence in the
Movie Track.

Movie Track in Frames mode

Frames do not display properly if you
change zoom settings during playback.
Black frames are drawn until playback is
stopped. You should stop playback before
changing zoom settings if you want to view
frames.

Blocks

Blocks mode displays the Movie Track as
blocks of compositional data. Blocks are
outlined wherever clip boundaries existed
before export from the original program.
Names from the original clips are retained.
For example, two clips edited together
without any transitions or effects, and



named “House Ext” and “House Int,” will
appear as two blocks bordering each other
with those names.

Videa Track Sirimbledom | Thearte Gettinginto
zom zign Cag

In -
cut response
0
GERRY
blocks

Movie Track in Blocks mode

In Blocks mode, you can place the cursor
on the Movie Track, then press Tab move
to the next video edit in the track.

To set the view for the Movie Track:

= On the Movie Track, select “frames” or
“blocks” from the View Options pop-up
menu.

4 Set the compression level for the video
capture from the Compression Level pop-
up menu.

AYRZm
AYRZm
AYR4m
AYREm
AYR2s
AYRIs
AYR4s
+ AVREs
AYREs
AYRIs
AYR12
AYRTO
AYRTOE
AYRT
AYRTS
AYRTSE

Setting the compression level (AVoption)

Recording Video

To set video recording options:

1 Create a new Movie Track. You can also
use an existing Movie Track if it does not
contain a movie.

2 Select a video format by clicking the
Track options button (see Figure 3 and
Figure 4), then selecting Video Format. You
can select NTSC or PAL format.

3 Select the video input you are using by
clicking the Record options button, then
selecting Video Input. You can select Com-
ponent or Composite input (AVoption and
AVoption XL), or S-Video or SDI
(AVoption XL only).

Setting the compression level (AVoption XL)

5 Select the target hard drive volumes for
the video capture. Target volumes capture
video in order, from the first (top) to the
last (bottom). In the following illustration,
Video-0 captures video first, followed by
Audio-0, then Audio-1.

As you add or remove volumes from the
track, the available record time is updated
to reflect available disk space and compres-
sion settings. The time displayed is approx-
imate.

Videg-0

Audio-1

Target volumes for video capture
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To record video:

A Note that if there is already a movie on the
Movie Track, the movie will be replaced, re-
gardless of where you start recording.

1 Place your cursor at the point you want
to start recording, or select a range of time
for the recording. You can make this selec-
tion on a timeline or on a track. If you
make this selection on a track, make sure
that Edit and Timeline selections are
linked.

2 Record enable the track by clicking the
Record button.

3 Click Record in the Transport window to
enable recording.

4 Start playing the video source.

5 Click Play in the Transport window to be-
gin recording.

6 Click Stop in the Transport window to
stop recording.

MachineControl

For far more accurate video recording, use
MachineControl to remotely control your
video source machine in synchronization
with Pro Tools. MachineControl is op-
tional software. Contact your dealer for
more information.

Blocks mode is recommended when re-
cording to the Movie Track with Machine-
Control.
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Exporting Files from Avid
Programs

If you already have a project that was cre-
ated on an Avid video authoring system,
you can export it to an OMF file so the ma-
terial can be imported into your AVoption
or AVoption XL system. This exchange of
data between systems is significantly faster
and easier than other methods, such as lay-
ing-off to tape and re-digitizing. This sec-
tion uses a Media Composer project as an
example.

DigiTranslator

DigiTranslator is included with your AVop-
tion or AVoption XL package. Use Digi-
Translator to convert OMF files containing
video and audio into Pro Tools session files.
You can also use it to export audio material
from Pro Tools sessions into OMF files for
import into other systems. Refer to your
DigiTranslator documentation for more de-
tails.

What AVoption and AVoption XL
Import

AVoption and AVoption XL import only
fully rendered (flattened) compositions,
and will not play video effects or transi-
tions that require special video hardware,
or any areas of a sequence that require mul-
tiple, real-time video streams. If you import
such a sequence, you will see black frames
in place of these transitions.



What to Export

When you export from your Avid software,
you have two choices. You can export the
audio and video from a project, or you can
export the video only.

Video and Audio

If your Media Composer project has video
and audio in it, export both the video and
the audio to the OMF file.

Video Only

If you have already started audio post pro-
duction in Pro Tools and you want to re-
place the Movie Track with a more recent
version, or your Avid project has no audio
in it, export the video only. Then, if the
video in your project changes, you can ex-
port video only, then import that video
into AVoption or AVoption XL to stay cur-
rent with the project.

Prepare for Export in Media
Composer

To prepare a Media Composer project for
OMF export and use with AVoption or
AVoption XL:

0 Make sure all media for the project is on-

line.

o0 Render all effects in advance. OMF ex-
port does not automatically render effects
during the process, so if you want to see
them, you must render effects before you
export.

Exporting from Media
Composer

To export a file from Media Composer:

1 Select the material to export by doing
one of the following:

0 To select specific tracks in a clip or se-
quence, enable those tracks in the Track Se-
lector panel, and disable all others.

o To export part of a clip or sequence, mark
IN and OUT points to export the marked
range from a bin or monitor, and select Use
Marks in the Export Settings dialog box. If
you mark an IN and no OUT point, the sys-
tem exports from the IN mark to the end of
the clip or sequence.

0 To export the entire clip or sequence, de-
select the options Use Enabled Tracks and
Use Marks in the Export Settings dialog
box, and make sure the topmost track in
the project is monitored.

0 If using different drives to transport the
project, consolidate the project.

2 Choose File > Export.
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Export File Type:

(O Avig Lo Pxchangs
O iab Delmiag

@ OMFI Composition Standard - AIFC +

[ Video and Audio « |

Version OMFL 20

[ with Media
) QuickTime [ Video and Audio w |
{0 Sound
) Graphic PICT -
ok ) (Cancer]

Export File Type dialog in Media Composer

0 Under Export File type, select OMFI com-
position.

o If importing video and audio into an
AVoption session, select Standard-AIFC
and Video and Audio options.

o If importing video only into AVoption,
select Video Only.

0 Usually, you should export an OMF file
that only refers to the audio and video files
that already exist on the hard drives. For
this reason, it is recommended that you do
not export With Media.

3 Set the Version to OMFI 2.0.

4 When you finish setting export options,
click OK.
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Importing Files into
AVoption and AVoption XL

Once you have an OMF file for your
project, you are ready to import it. If your
OMF file is Video Only you can simply im-
port it as the Movie Track in AVoption or
AVoption XL. If your OMF file has Video
and Audio, you can use OMF Tool to create
a Pro Tools session from the audio files,
then import the Movie Track separately.

You can use DigiTranslator to translate
video and audio simultaneously. See your
DigiTranslator documentation for details.

To create a Pro Tools session with OMF Tool:
1 Launch OMF Tool, and choose

OMEF Tool > Convert OMF to Pro Tools.

2 Select the OMF composition file.

3 Name the Pro Tools session, and choose
Pro Tools 4 as the version to save.

4 Set all other options based on your ses-
sion requirements, and click Save when
you are done. The resulting file is a

Pro Tools session. OMF Tool ignores the
video information.

To open your session with AVoption or
AVoption XL:

1 Choose File > Open Session.

2 Find the Pro Tools session created by
OMF Tool, select it, and click Open.

To import a video into the Movie Track:
1 With a session open, choose Movie > Im-
port Movie.

2 Select the OMF file created by the Video
Only or Video and Audio export, and click
OK.



Playing the Movie Track

Video plays back automatically when you
play a session that includes a Movie Track.
There are several different options for view-
ing and synchronizing the video and audio
tracks.

Movie Online

When the Movie is online, the Movie Track
plays along with the audio session. The
Movie’s frame location is updated every
time you place your cursor in a new loca-
tion, and the Movie track is scrubbed along
with the audio tracks. The Movie is also up-
dated whenever you drag or nudge an
audio region or an automation breakpoint.
The Movie is online by default.

Online Edit and Selection
Behavior

When Pro Tools is in Grid mode or set for
Loop Playback, and the Movie is online,
Pro Tools will always place your cursor or
Edit selection on legal frame boundaries. If
you make a selection that is outside of
frame boundaries, or you place your cursor
outside a frame boundary, Pro Tools will

warn you with a dialog and move your se-
lection boundaries or cursor to the nearest
frame.

To prevent this, take the Movie offline, go
out of Grid mode, or disable Loop Playback
if you are editing audio that does not re-
quire placement at the beginning of a
video frame.

Movie Offline

If you temporarily do not wish to view the
Movie or have the Movie frame location
updated, you can take the movie Offline.

This is useful if you are working with audio
and do not need to see the video.

To put the Movie online:
» Select Movie > Movie Online.

To take the Movie offline:
= Deselect Movie > Movie Online.
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Playback Viewing Options

Video can be viewed on a separate NTSC or
PAL video monitor. Video can also be
viewed in an on-screen window (AVoption
only).

Using a Playback Monitor with
AVoption

The ABVB video cable includes video out-
puts to connect an NTSC or PAL video
monitor. You can connect a monitor that
has component or composite video inputs.

The video card will display full-screen
video on the playback monitor.

To connect a playback monitor:

» Connect the composite output or the
component outputs from the ABVB cable
to the proper input or inputs on the back of
your video monitor.

Using a Playback Monitor with
AVoption XL

The Meridien I/O Box includes video out-
puts to connect an NTSC or PAL video
monitor. You can connect a monitor that
has component, composite, S-Video, or SDI
video inputs.

The video card will display full-screen
video on the playback monitor.

A The Meridien 1/0 Box can only output from
either S-Video or Component outputs. You
must set this option in your Movie Track. See
“Setting S-Video or Component Output” on
page 34 for instructions.
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To connect a playback monitor:

= Connect a composite output, the com-
ponent outputs, the S-Video output, or and
SDI output from the Meridien I/O Box to
the proper input or inputs on the back of
your video monitor.

Window Playback

(AVoption Only)

Select Windows > Show Movie Window to
view the Movie Track in a window on your
computer screen. This window will display
the video in real time. You can resize or
move this window around your screen
when playback is stopped.

The Movie window will give you the best
performance when it is displayed on a
monitor connected to the ABVB VGA mon-
itor output. With a monitor connected to
your Macintosh graphics accelerator, per-
formance will not be optimal, and may not
work at all.

Movie window (AVoption only)

A You cannot view the video input signal in a
window. In order to view video input, you must
connect an external monitor to the Composite
or Component outputs of the ABVB card.



If the Movie window is partially blocked by
another window on your screen, playback
will slow or “stutter” as your computer’s
CPU attempts to display the video.

Movie window size and position are saved
with your session.

To show the Movie Window:
= Select Windows > Show Movie Window.

To resize the Movie Window:

» When playback is stopped, click the
lower right corner of the Movie window
and drag to shrink or enlarge the window.

Movie Aspect Ratio

(AVoption Only)

You can set the Movie window to automat-
ically snap to one of two window aspect ra-
tios (4x3 or 16x9), or to allow uncon-
strained resizing.

By constraining the aspect ratio, you can
see a more accurate on-screen representa-
tion of the final video. Use 4:3 for video
destined for television, and use 16:9 for
wide screen film-format viewing.

To set the Movie window aspect ratio:

1 Select Movie > Show Movie Window.

2 Select Movie > Movie Window Aspect Ra-
tio.

3 Choose 4:3, 16:9, or unconstrained as the
aspect ratio.

Spotting the Movie Track

You can spot the entire Movie Track to a
new SMPTE frame location. Although
AVoption and AVoption XL retain the
names and positions of different “clips”
when you import a Movie Track, you can-
not spot separate video clips. When you
spot the Movie Track, the whole track or se-
quence is moved to the new frame location

you specify.

To spot the Movie Track to a new frame
location:

1 Set the Main Timebase display to Time
Code using the pop-up menu.

K Feet Frames
Sarnples

2 Enable Spot mode by clicking the Spot
button.

Shuffle | Spot
Slip Grid

3 Select the Movie on the Movie Track with
the Grabber tool.

4 In the Spot dialog, specify a new SMPTE
frame number for the start of the Movie
Track. In this dialog, you can press “+” or
“-” on the numeric keypad, enter a num-
ber, and press the Enter key to add or sub-
tract that number of frames from the

currently selected time field.
5 Click OK when you are done.
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Video Editing With
AVoption or AVoption XL

AVoption and AVoption XL do not support
video editing.

You cannot use the Cut, Copy, and Paste
commands with the Movie Track. You can,
however, Spot the Movie to a new location.

A You cannot import or capture multiple video
files to a Movie Track. Once a Movie Track con-
tains video, importing or capturing new video
will replace the entire track, regardless of the
original and new Movie locations.
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